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Introduction 
Among other functions, CAN-8 allows instructors to monitor the students and their 

progress via its Tracker screen.  

 

This chapter discusses the different options and tools available to the instructors to 

facilitate students' monitoring, to change the lesson mode from practice to test, to view 

the students' progress, listen to their recordings and assign them marks.  

 

Familiarity with the previous chapters of this manual is strongly suggested before starting 

this one as it refers to topics previously addressed.  

About the Tracker 
The Tracker Screen allows an instructor to: 

• See the names of all the students who have accessed the lesson and identify those 

currently signed on.  

• See a graphical display of the progress of each student as they go through the 

lesson.  

• Print the students' progress.  

• Select and listen to each recording made by a student.  

• Select and see any incorrectly answered Multiple Choice and Fill-in questions for 

a student.  

• Select an item for a student and record special instructions for that student. The 

student is then directed to the selected item and given the special instructions.  

• Speak in real time to the whole class.  

• Talk individually with a single student.  

• Enable a class or individual test, monitor students taking the test, mark answers 

and review the test.  

• Control data display and storage for students accessing the lesson.  

Accessing the Tracker 
To access the Tracker, chose any one of the 3 following options:  

• First select a lesson from the main CAN-8 menu, and then press the Tracker icon 

located in the tool bar on the left of the interface.  
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• Select the lesson title from the main CAN-8 menu, right click on it, and then 

select Track Item from the contextual menu.  

 

• Select the lesson title from the main CAN-8 menu, and then select File > Track 

Item from the menu bar.  

 

Note:  

If the Tracker button or Track Item option is greyed out, check that the lesson is 

selected (highlighted blue in the tree menu).  

Make sure that the item you are trying to track is a lesson and not a submenu, an 

internal command, or some other type of CAN-8 function.  

Navigating within the Tracker 

 

 

The blinking cursor indicates which student and which item is currently selected. The 

user cell is surrounded with a black border, and the cell where the cursor is placed blinks.  

 

In this example, the cursor is on the third item box for User 14.  

 

The Up, Down, Left and Right arrow keys of the keyboard can be used to move the 

cursor from student to student or from cell to cell. The Enter key opens the content of the 

cell.  

 

Alternatively, the cursor can also be moved by mouse clicking on a different cell.  
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The currently selected item is identified at the bottom left corner of the screen. The item 

index in the plan is followed by the item name (or title). The mark given for the response 

(if any) is shown over the assigned mark (if any) for the item.  

 

The Tracker's Interface 
The Tracker’s interface is placed within the user's main work area, thus leaving the 

User’s Tab Bar visible and available at all times for the instructor:  

 

 

This allows to easily switch from a Tracker to a lesson, a planner or even another Tracker 

without having to exit the Tracker screen.  

 

Tracker tabs can be easily identified by the icon located on their left.  

 

Since up to 7 tabs (including Planners, Trackers and Students Programs tabs) can be 

opened simultaneously, this helps locate opened Trackers at a glance. The lesson's name 

also shows on that tab for more clarity.  

 

A blue tab (as in the image above) shows which tab is presently active. Tabs are 

otherwise grey.  

 

The Tracker's interface is composed of:  

• A Header Bar that that references the information displayed below. Also used to 

sort the information by category and relevance.  

• A User List, where the name of all users who have accessed the lesson are 

displayed. and their status: offline or online.  

• A Progress Area where users' data is displayed by colour code on a per item basis.  

• An Answer Display section, where the students' recorded data can be viewed or 

listened to:  

o If it is audio data, a sound graph is displayed with the student's answer, as 

in the illustration.  

file://///10.0.0.253/public/release/prerelease/manual/english/english/monitor.html%23i303
file://///10.0.0.253/public/release/prerelease/manual/english/english/monitor.html%23i304
file://///10.0.0.253/public/release/prerelease/manual/english/english/monitor.html%23i305
file://///10.0.0.253/public/release/prerelease/manual/english/english/monitor.html%23i321
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o For written answers, this section displays a text area with the students' 

typed answers. 

• A Marking Tools section, where tools are available to assign marks to answers, 

calculate mark totals and change the view of the Tracker cells. 

 

 

NOTE: 

It is important to be familiar with the layout of this interface and the names that have 

been given to each area of the Tracker as they will be referred to all along this chapter 

The Header Bar 

This header bar is divided in several sections, each describing the data displayed. 

 

There are 3 different headers:  

• Name. Under that header is the list of users who have accessed that lesson since 

the last time the Tracker was refreshed or the system first installed.  

• Progress. The data in that section is displayed as colour coded cells. Each cell in 

that area represents one exercise (or lesson item). The entire section, made of 

coloured and/or empty cells, represents the entire lesson.  

file://///10.0.0.253/public/release/prerelease/manual/english/english/monitor.html%23i332
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• Mark. Marks listed in this column represent the mark per user for a specified 

section of the lesson.  

o The Mark section can be absent if there is no need to score the results.  

o There could be more than one Mark field in the header bar if it is 

necessary to mark the test by subsections. In which case, the Mark listed 

in the column below is the sum from either the first cell (or item) to the 

last cell directly before the Mark section, or from the first item after the 

previous mark section, to the last cell directly before the new Mark 

section.  

 

 

Each of these headers can be clicked on to sort the information listed under.  

If you click on the Mark header, the information is listed from the highest mark to the 

lowest one.  

The User List section.  

This section displays the names of all students who have accessed the lesson since the 

Tracker was last refreshed, and their data is kept available until deleted.  

 

By default, users are listed by the order in which they signed on to the lesson. However, 

if you click on the Name header, the list will be sorted alphabetically.  

User status.  

 

 

Users names are displayed on different background colours depending on their status:  

• If the student is currently signed on, the name is displayed in Black on a blue 

background.  

• If the student is currently taking a test, the name is displayed in Black on a green 

background.  

• If the student has accessed the lesson in the past but is no longer signed on, the 

name is displayed in black on a white background.  

• If the student is calling for help the name is displayed in black on a red 

background.  
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Customized Student List Display 

Over time, the student list may become too large or cluttered to easily view the progress 

of only the few students the instructor wishes to monitor or it may be preferable to view 

only a specific group of students for monitoring purpose.  

 

Several tools are available to help reduce the display to a sub-listing of students, or 

change the order of the list:  

 

1. Alphabetically 

o Click on the Name header bar  

This will sort the list of users in listed alphabetical order.  

 

Can be combined with any function that minimizes the display, like View By Class, 

View Own and View Online.  

 

The system will keep the settings for that Tracker for the entire CAN-8 session. The 

default display will be restored when the instructor logs back in CAN-8 for a new 

session.  

o Select VIEW > SORTED from the menu bar will also sort students 

alphabetically.  

2. By progress: click on the Progress header bar 

Lists all users who have entered the lesson by order of progress.  

 

This option is only available from the Header bar. . If the progress section is separated by 

mark columns, each progress section can be ordered independently.  

 

Can be combined with any function that minimizes the display, like View By Class, 

View Own and View Online. 

3. By score: click on the Mark header in the header bar 

This option sorts the students on the Tracker screen by score; the highest scoring student 

is displayed at the top of the screen.  

 

If there is more than one Mark section, each section is sorted individually.  

 

The total scores for each student out of the maximum possible (only for the questions 

taken) are shown at the right of the screen. As students take more questions or marks are 

given for items recorded, the scores and the maximum for the questions are updated. 
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However, the list of students is not sorted again until Show scores is selected again.  

 

Can be combined with any function from the Simplified display section below. 

 

4. Restricted view:  

 
• VIEW > BY CLASS, and then select the class name.  

Displays only the list of students who belong to the class(es) selected.  

 

For more information on how to select classes to view, read the Display By Class section.  

 

Can be combined with View Own Students and View Online Only to further limit the 

display or with any of the sorting options. 

• VIEW > ONLINE ONLY  

Displays only the list of users currently using the lesson. Their name is highlighted in 

cyan.  

 

Can be combined with View Own and View By Class to further limit the display and 

with any of the sorting options. 

• VIEW > OWN STUDENTS  

Reduces the list to only the students who have been registered by the instructor who is 

monitoring.  

 

If the students were registered via an import file or by another instructor, selecting this 

option would display an empty Tracker, even if the students were added to the 

instructor’s class.  

 

Can be combined with View By Class and View Online Only to further limit the display 

and with any sorting options. 

 

Note:  

Using one of the above options to simplify the list display does not delete the other 

users' data from the Tracker. It only hides it. To view the full list again, select VIEW > 

ALL STUDENTS from the menu bar, except if you had selected VIEW > By Class as 

addressed below.  

Some of these functions can be combined.  

The settings are kept for that Tracker for the duration of the CAN-8 session.  

 

file://///10.0.0.253/public/release/prerelease/manual/english/english/monitor.html%23i317b
file://///10.0.0.253/public/release/prerelease/manual/english/english/monitor.html%23i317b
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If when using the simplified display functions, the user restricts the display to nothing 

at all, the following message will show:  

 
You must de-select some of the options checked in the View menu. 

Display By Class 

Just like classes can limit the menu displayed to the users, classes can also limit who the 

instructor can monitor:  

• Instructors belonging to NO class at all will be able to monitor all students at 

any time.  

• Instructors belonging to one or more class(es) will only be able to monitor the 

students who belong to the same class(es) as the instructor.  

Example:  

• Inst1 does not belong to any class.  

• Inst2 belongs to Class A and Class B  

• Students from Class A, B, C and D all took TEST T.  

o When INST1 monitors the TEST T, the Tracker displays all the students 

registered in the system including those from class A, B, C and D who 

entered the test, in the order they entered it.  

o When INST2 monitors the TEST T, the Tracker displays only the 

students from Class A and B who entered the test, in the order they 

entered it. INST2 will never be able to monitor students from class C or 

D  

o Both instructors can use the VIEW > BY CLASS option to limit the 

display to one or more classes, but whereas INST1 can select any (one or 

more) of the classes available in the system (A, B, C and/or D), INST2 

can only limit the display to one of the 2 classes he/she belongs to (A or 

B).  

 

VIEW > BY CLASS Procedure  

From the menu bar, select VIEW > BY CLASS.  
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The Class selection window is in 2 sections: 

• The available system's class list on the right  

• The selected class list on the left.  

By default, no class is selected; therefore, none is listed on the left panel.  

To select the class to view, either double click on the class name in the right panel and 

the class code will appear on the selected class section, or click on the class code, and 

then click the Move button.  

 
 

You can toggle the classes from one side to the other by selecting them with the mouse 

and using any of the Move buttons in the center section of the window.  

 

Select OK When the selection is complete.  

NOTE:  

It is possible to select more than one class to view.  

To return to the default Tracker view that includes all the system users, either move all 

classes from the Selected Classes section to the Available Classes section, or vice versa.  
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The Progress Area.  

The entire section, made of coloured and/or empty cells, represents the entire lesson.  

 

To the right of each student's name is a set of colour-coded boxes that show the student's 

progress through the lesson.  

 

Unless the user list has been customized, the first cells row represents the answers of the 

user who first connected to that lesson. But if you click on the Progress header, the data 

below will be listed by order of progress for the section:  

• The lines with the most correct answers first 

• followed by the lines with the most answers, including wrong answers  

• and finally, the lines with less answers, or no answers at all.  

Independently of the order in which the student is recording the answers (for example 

when a lesson is set to random mode, the student may have to answer the last item of the 

lesson before being presented with the very first item of the same lesson) the cells will 

always be placed in the order they appear in the planner.  

 

Each box or cell corresponds to a lesson item that requires a response from the student. 

That is, Instruction, Teaching, and Conversation items do not have cells to represent them 

since the student cannot record in these items.  

 

As soon as a student submits an answer (selects Next after recording in an item), the 

corresponding cell in the tracker is filled with the color that represents its content type. If 

the student skips an answer, the corresponding cell remains empty.  

 

The cells' colour code is as follow: 

 

 

 

Response 

Type 
Colour Code 

   

None 
The student has not given an answer to that item. 

The cell is empty. 

   

Audio or 

text 

The student has recorded a response and has pressed 

the Next key. The response is now available for 

listening. 

   

Audio or 

text 

The instructor has listened or viewed to the response 

for this item. 

 
 

 

Audio or 

text 

The instructor has recorded special audio 

instructions (left an audio message) for this item, but 

the student has not yet listened to the message. 

 
 

 

Audio or 

text 

The student has listened to the message that was left. 

If the student was required to redo the item, the new 
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response has been recorded.  

 
 

 

Text 
The student has correctly answered this Multiple 

Choice or Fill-in question item.  

  
 

Text 

The student has incorrectly answered this Multiple 

Choice or Fill-in question item. The incorrect answer 

is available for review by the instructor.  

Note:  

If no mark was assigned to the item, the largest cell will display None instead of 

the score.  

 

The default display shows fixed size cells with icons.  

 

Since a lesson can hold up to 240 items, all items cannot be displayed all at once on the 

same screen and a horizontal scroll bar at the bottom of the display area allows to view 

the rest of the lesson. 

 

Alternatively, the cells can be displayed in smaller or larger sizes to either give a global 

view of the entire Tracker or show additional details about each recorded cell.  

 

To change from the default display to a global display or a more 

detailed one, click on the icons or of the zoom bar located at the bottom right of 

the interface or slide the zoom cursor at the desired level.  

Defa

ult 

displa

y  

Glob

al 

Displ

ay  

 

 

Detai

led 

displa

y 
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Answer Display section 

 

All items that need to be evaluated by an instructor are represented in the progress area 

by a grey cell. This includes all items that required a recorded audio answer, and the write 

item.  

 

For monitoring purposes, students' answers are divided into two types: Those the 

computers can mark, and those that need to be marked by an instructor.  

 

Whereas a computer can correct and mark the answer from a Multiple Choice or a Fill-in 

question by comparing it to the instructor's answer, it cannot mark an answer to a 

question that does not meet these criteria.  

 

These items are easily identified in the Tracker by their colour.  

 

To view or listen to an answer that requires an instructors' evaluation, double click on its 

corresponding cell.  

 

 
NOTE: 

 

If you receive this message when clicking on a cell, the answer given by the student may 

no longer be valid, since the question has been changed after the answer was given.  

 

However, at the time the answer was given, it might have been correct.  

Listening to Audio Responses 

While a student is in an item that requires a recorded response such as an Example, a 

Read, or an Ask item, the student may record the response, listen to it, and re-record it 

several times to try and get it right. The item indicator (or corresponding cell in the 

Tracker) remains empty (light grey).  

 

Only when the student has completed a satisfactory recording and presses the Next 

button does the indicator turn grey to show that the recording is available for listening by 

the instructor.  
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The instructor can then listen to the student's answer and to the original audio that was 

recorded in the item by the instructor.  

Students Recordings 

To listen to students' recordings the instructor can:  

• Using the mouse, select the item by clicking on it.  

• Right click on the cell and select Listen to Student Response  

 

• Using the arrow keys of the keyboard, navigate to the cell you wish to listen to, 

and then press F2.  

The Sound graph of the student response appears on lower part of the Tracker interface 

(Answer Display section) and the response starts playing automatically.  

 

The Play and Pause buttons can be pressed to listen repetitively to the recording, or part 

of it.  

Alternatively, the Play cursor can be moved by clicking the mouse on any spot on the 

volume display. The sound will play from that point.  

Sample/Example Recordings 

It might be necessary for the instructor to listen to the question the student was 

responding to or compare the student's recording with the audio example given: 

• Press the Example button in the button bar.  

• Right click again on the cell you are listening to and select Listen to Instructor 

Audio  

 

file://///10.0.0.253/public/release/prerelease/manual/english/english/monitor.html%23i302a
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The sound graph of the instructor's recording appears above the student's sound graph. To 

differentiate them, the audio part of the sound graph is displayed in cyan for the 

instructor, and green for the student.  

 

To navigate from one recording to another, the instructor can:  

• Use and on either sound graph respectively.  

• Use and in the button bar, where the Play button activates the 

student audio and the Example button activates the Instructor's audio.  

• Click directly on either volume graph to place the sound cursor at the desired pace 

and activate it.  

• Use any combination of the above methods.  

Once the recording has been listened to:  

• select the Exit button located at the top right corner of the Sound graph if you 

wish to exit the listening mode.  

• Or click on the next item cell if you wish to continue listening to more answers.  

• Alternatively, use the Arrow keys and the F2 key to navigate through the Tracker 

and listen to another item.  

As soon as you exit the volume graph, or move to another cell, the previously selected 

item now appears in green to indicate that it has been listened to.  

Note:  

When entering a Tracker, you may notice that the Progress Display area of the Tracker 

is full and extends over the Answer Display area. If such is the case, when you click on 
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the cell to listen to the student's recording, the progress display is reduced in size to allow 

space for the sound graph.  

 

If the cell you are listening to is located within the Answer Area (the lower part of the 

progress area), the entire Tracker row is then shifted above the Sound graph, thus 

allowing to view and listen to the other answers from that same student.  

If necessary, a scroll bar will appear on the right side of the progress area to view the 

cell rows that were shifted upwards.  

Viewing Students' Written Responses 

The computer corrects the student's answers to Multiple Choice and Fill-in answers.  

Question items that are answered correctly are displayed in cyan cells. Question items 

that are incorrect are displayed in magenta cells.  

 

These answers can be displayed for verification, independently of their status.  

Multiple Choice Items 

 

In the Tracker, the answer to a Multiple Choice is represented by a Cyan cell if it is 

correct or a magenta cell if the answer was incorrect.  

 

Double-clicking on one of these cells displays the question text and the answers. The 

response the student selected is shown on a red or on a green background.  

• If the answer the student selected was correct, the answer is displayed on a 

green background.  

• Incorrect answers are displayed on a red background.  

The choices available and their status (correct or incorrect), as set by the instructor in the 

planner, are also displayed and colour coded:  
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• The answer(s) the instructor set as correct in the planner are displayed in 

green on a dark grey background.  

• The answer(s) the instructor had set as wrong in the planner are displayed in 

red on a dark grey background.  

 

 

In the example above, the student chose 1. 

for answer.  

• 1. was the correct choice as set by 

the instructor. 

• 2. and 3. were set as wrong answers 

in the planner.  

 

Note that it is possible to set more than one 

answer as correct. If such is the case, the 

answer that was set as correct, yet has not be 

chosen by the student as another possible 

true choice is displayed in green on Dark 

grey background. 

In the example above, the student chose 2. 

for answer.  

• 2. was not the correct answer, and 

therefore the student's response is 

displayed on red background.  

• 1. was set as correct in the planner 

but the student did not select it.  

• 3. was set as an incorrect answer 

and the student did not select it.  

Fill-In items 

In the Tracker, answers to a Fill-in question are represented by cyan cells if correct, 

magenta cells when incorrect.  

 

When clicking on one of these cells, the question text and the student's response is 

displayed.  

 

 

In the above image, the response given was 

correct. The student's answer is shown in the 

black text area. 

The Answer given in the above example is 

wrong. The student's wrong answer is 

shown in the black text box, the correct 

answer is shown under and is highlighted 

in green. 
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Select the exit button on the Answer Display area to return to the full Tracker screen or 

select the next cell to view the next item.  

Note:  

If the Progress Display area of the Tracker is full and expends over the Answer 

Display area, selecting the cell to view reduces the progress display area to allow space 

for the student answer.  

If the cell you are viewing is located within the Answer Area (the lower part of the 

progress area), the entire Tracker row is then shifted above the Answer display area, thus 

allowing to view and listen to the other answers from that same student.  

If necessary, a scroll bar will appear on the right side of the progress area to view the 

cell rows that were shifted upwards.  

Note also that when exiting a Fill in the blank or a Multiple-Choice question, the cell's 

colour does not change.  

Once the instructor has listened to or viewed the content, this cell turns green. The 

instructor may also give the item a mark at this point.  

Leaving a Message 

After listening to a response, the instructor may decide to leave some oral feedback for 

the student, or decide that the student should redo the item. Note that when a message is 

left, the student at login will receive a notification of the message  

 

The student can then select a link and will be brought directly to the lesson and the item 

where the message was left.  
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Note that the student can opt out and proceed with another lesson. The alert will come 

back as the student opens the main menu, until the message has been played.  

All messages left in an item over time are kept and accessible by the students until the 

students’ answers are deleted from the tracker.  

 

In this example, the instructor has left 7 messages  

To listen to the messages, the student can click on this button, then select the message to 

play 

 

Procedure to leave a message 

1. Select a cell in the tracker 

2.  Press on the record button or right click on the cell and select Record 

a Message for Student. 

3. The message volume graph is displayed in red. 

4.  Once the message is finished recording, and as soon as the instructor either 

exits the graph or selects the next cell, the following message is displayed:  
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• OK - The student will have to redo the exercise. The student will not be 

able to move to another exercise until this one is re-done.  

• NO- The student will hear the message, but redoing the exercise is 

optional.  

• CANCEL- removes the message from the item.  

5. As soon as an option is selected, the cells turn red to show it now includes a 

message.  

6. Once the student has listened to the message, the cell turns green if no answer 

was required, yellow if a new answer has been submitted..  

7. Any item on the Tracker Screen, whether the student has answered it or not, 

can be selected for a message.  

Marking Tools section 

When evaluating a test, instructors can mark the answers as long as the item has been 

assigned a mark in the Planner.  

 

For more information on how to assign marks to items, please return to the Assigning 

Marks section of the previous Chapter.  

Marking an Item 

If an item was assigned a mark (1 to 10) in the lesson plan, the instructor can score the 

answer in the Tracker.  

 

Multiple Choice and Fill-in questions are corrected and scored by the computer. A correct 

answer gets a full mark; an incorrect gets zero. If the item was set with the Part Mark 

option in the planner, a partially correct fill in the blank answer will get a partial mark.  

 

For recorded answers, the computer does not mark the answer. The instructor must mark 

the answers manually.  

 

 

file://///10.0.0.253/public/release/prerelease/manual/english/english/author.html%23i261
file://///10.0.0.253/public/release/prerelease/manual/english/english/author.html%23i261
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The student's mark and the maximum mark available for the item are displayed at the 

bottom left of the screen. The white mark box is empty if no mark has yet been given by 

the instructor.  

 

To mark the student’s work, the instructor must first click on the cell in the Tracker, and 

then simply type the digit corresponding to the mark desired. There is no need to click 

on the mark box, or to remove the existing mark if any. Simply type the number that 

will become the mark.  

 

The score cannot be greater than the maximum mark allowed for the item.  

Changing a mark 

Marks can be edited at any time simply by re-selecting the cell and typing a different 

number.  

 

For items that are marked by the computers, it is also at the instructor's discretion to 

change the mark assigned. The computer might for example mark a missing capital letter 

as wrong, and the instructor decide to credit part of or the entire mark to the student.  

 

The procedure is the same as for assigning a mark, select the item, and then simply type 

the desired number. There is no need to select the mark area first, it is pre-selected by 

default.  

Display User Marks 

Once the item has been evaluated and marked by the instructor, the mark can be 

displayed in the Tracker's cells on a per item basis.  

To do so, the instructor must set the Tracker display to its highest zoom level.  

 
 

 

Marks are displayed in the cell only if a mark was assigned for the item in the planner. If 

no mark was assigned to the item, the word None will show instead. If the item has a 

mark assigned, but the student did not record an answer, the cell will be empty.  

 

For more information about the Tracker display levels or the cell colour codes, please 

refer to the Progress Area section of this manual.  
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Display Mark and Cumulative Mark columns. 

Additional columns that display the user's marks subtotal and final marks, can be inserted 

in the Tracker by the instructor.  

Mark Calculation Options 

 

The mark out of the maximum mark assigned and the average in percentage are displayed 

in these columns.  

 

 
 

The marks shown in the mark columns may be calculated in two different ways. One 

option is to total the mark obtained by the student only on questions that were attempted. 

The other more traditional way is to total the mark out of the total assigned marks for all 

questions, even if they were not answered.  

 

The EDIT > PREFERENCES > Tracker dialog tab allows the setting of the method for 

calculating the content of these columns.  

 

These options are in the Mark Calculation section of this form (lower section)  
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Option Tracker display 
Descriptio

n 

 

 

Gives the 

total mark 

and 

average in 

percentage 

of the 

items 

answered 

only.  

 

 

Gives the 

total mark 

and 

average in 

percentage 

of the total 

points 

available 

in that 

section.  

 

Adding Mark columns 

Mark columns can be added to the Tracker by simply pressing the left mouse button over 

the Mark calculator icon, and then while still holding the mouse button down, 

moving the mouse cursor to the location where the column should be. 

 

A thin vertical black cursor will show where 

the mouse is pointing.  

 

Upon release of the mouse button, the mark column will appear where the cursor was. It 

shows the subtotal of the marks earned by the student from the beginning until this 

column, or for items located between the last column and this one.  
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Cumulative Marks 

Whereas subtotals give the score obtained within a defined section of the lesson, 

Cumulative marks show the student's total score from the first item answered in the 

Tracker to the item placed right before the mark column.  

 

To display the student's cumulative score:  

• First place a mark column in the Tracker (see procedure above).  

• Right click on the mark column to bring up the popup selection menu.  

 

• Select the Cumulative Mark option.  

Follow the same steps as above to change a column that was previously selected as 

Cumulative Mark to Subtotal Mark  

 

Cumulative Mark column can be differentiated from subtotal columns by their 

background color and icon:  

Subtoatl 

Column 

 
 

Cumulativ

e mark 

Column 

 
 

 

NOTE:  

The settings in the Mark Calculation section of the Tracker Preferences dialog also 

apply to the cumulative results.  
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Export Evaluation Marks. 

The marks obtained by the users can be made into a report that can be exported directly 

from CAN-8 into any application that read .csv files (Spreadsheet, word processor, etc,...)  

Export Procedure 

The report is created by selecting several cells for some (or all) students in the Tracker 

and dragging this out to another application it is to be used in. 

 

Use the Next Step button below to go through the detailed steps.  

 

Step 1 - Selecting 

 

Left click and hold the mouse button down on the first cell of the group of 

users you wish to export the marks. 
 

Alternative method: 

• Follow the procedure above till step 3  

• Right click on the selection.  

• Select COPY in the popup contextual menu.  

• Open the spreadsheet, or the software intended.  

• Place the mouse cursor where the data should be placed  

• Select EDIT > PASTE  

Export Format 

There are 3 selectable formats for these reports:  

• Scores Only format: Only export student names, item names, and per item scores.  

• Mark Out-of format: exports student names, item names, per item scores and 

mark the item is out of.  

• Defined Mark Columns Only format: In this format, only the mark summary 

column totals and the available score are stored.   
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The report format is selected in the Tracker Tab of the Preferences dialog box accessed 

through EDIT > PREFERENCES from the menu bar.  

 

These preferences are set in the instructor's profile and can be changed at any time.  

 

The system will keep the last settings selected as the default settings next time the 

instructor signs in.  

1. Scores Only 

In this format, only the mark for each item is stored. It is assumed that the total mark each 

item is out of is either known or un-necessary.  

 

Report fields are as follow:  

First 

line 

Lesson_Na

me 

Lesson_na

me 
Type Ex. 1 Ex. 2 

..

. 
Ex. X 

Contains 
The name of 

the lesson 

The name of 

the lesson 

Type of 

report 

created: 

O, P or S 

Name of the 

first item 

Name of 

item number 

2 

..

. 

Name of 

item 

number X 

Subsequ

ent lines 

Student_na

me 
Student_ID O 0 to 9  0 to 9 

..

. 
0 to 9 

Contains 
The name of 

the student 

The 

student's 

user ID 

Indicates a 

Score 

Only type 

The score 

received for 

the first 

item 

The score 

received for 

the second 

item 

..

. 

The score 

received 

for item X 
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Exampl

e  

 

2. Mark Out-of format 

In this format, each field shows the mark the student received on the item and the 

maximum available mark on the item for all items in the Tracker.  

First 

line 

Lesson_Na

me 

Lesson_na

me 
Type Ex. 1 

Mark 

Out Of 
Ex. 2 

Mark 

out of 
etc... 

Contains 

The name 

of the 

lesson 

The name 

of the 

lesson 

Type of 

report 

created: 

O, P or 

S 

Name 

of the 

first 

item 

Maximu

m Mark 

for item 

1 

Name 

of the 

second 

item 

Maximu

m mark 

for item 

2 

Repeat 

until 

last 

item 

exporte

d 

Subsequ

ent lines 

Student_n

ame 

Student_I

D 
P 0 to 9  0 to 9 0 to 9 0 to 9 etc... 

Contains 

The name 

of the 

student 

The 

student 

user ID 

Indicate

s a 

Score 

Only 

type 

Mark 

receive

d for 

the first 

item 

Mark 

that item 

1 is out 

of 

Mark 

receive

d for 

second 

item 

Mark 

that item 

2 is out 

of 

Repeats 

until 

last 

item 

exporte

d 

Exampl

e  

 

3. Mark summary format 

In this format, only the mark summary column totals and the available score are exported.  

In order to export in this format, mark columns must be defined in the Tracker first.  

 

First Lesson Lesson Type Mar Out Percen C Cumul Out Percen
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line Name Name k Of t ative 

mark 

Of t 

Contain

s 

The name 

of the 

lesson 

The 

name of 

the 

lesson 

Type 

of 

report 

create

d: O, 

P or S 

Mark 

obtai

ned 

in the 

first 

subto

tal 

Max. 

Mar

k for 

that 

secti

on 

Percen

tage 

achiev

ed in 

that 

section 

Indicat

es the 

followi

ng 

column 

is a 

cumula

tive 

mark.  

Cumula

tive 

mark 

obtaine

d 

Maxi

mum 

mark 

for the 

sectio

n 

Cumul

ative 

percent

age 

Subseq

uent 

lines 

Student_

name 

Student

_ID 
S 0 to 9  

0 to 

9 

0 to 

100 
C 0 to 9 0 to 9 

0 to 

100 

Contain

s 

The name 

of the 

student 

The 

student 

user ID 

Indica

tes a 

Summ

ary 

forma

t 

record 

Mark 

recei

ved 

as a 

subto

tal 

Scor

e the 

subt

otal 

is 

out 

of 

Percen

tage 

for the 

section 

Indicat

es a 

Cumul

ative 

mark 

follows 

Cumula

tive 

mark 

Score 

the 

mark 

is out 

of 

Cumul

ative 

percent

age 

Exampl

e  

 

Include Legend 

 

The Include Legend In Dropped Data option is in the same section of the Preferences 

box. Checking this option will add an extra line to the exported data.  

 

The legend is placed at the end of the report.  
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Lesson Modes 
Unless otherwise specified, the lesson is used by default as a drill and practice.  

Students who access the practice lesson can record answers and take questions.  

However, the instructor can administer the lesson material as a test instead of practice. 

The test sequence proceeds through 3 steps:  

• Wait to start,  

• take test,  

• review results.  

The Test menu is accessed from the menu bar.  

 

The final marks for the test, including rank in class, can be displayed to the students 

as well.  

 

When the test menu is displayed, one of the first four options will be checked to 

indicate which one is currently in effect.  
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1. Practice 

In drill and practice students are given feedback by the colour of the items’ titles in the 

student menus. In this mode, correctly answered Multiple Choice and Fill-in questions in 

green and incorrectly answered ones in red. Recorded answers are displayed in green.  

 

 

 

• Green item titles are for correctly answered Multiple Choice and Fill-in questions 

and for all recorded answers, corrected or not.  

• Red item titles are incorrect Multiple Choices and Fill-in answers.  

• Black titles mean the item has not been answered.  

In this illustration, the 3 first items have not been answered, the next 3 have, but 2 are 

correct and one is wrong.  

NOTE: 

 When in practice mode, depending which Feedback option was selected in the 

Planner, the student may or may not receive feedback when taking a Multiple Choice or 

Fill-in Item. 

 Students have access to all previous oral messages left by instructors.  

2. Test Options  

There are 5 test options 
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Wait to start  

When this option is set, students cannot access the test. This allows the instructor to wait 

until everyone is logged on and start the test for all students at the same time.   

• Students attempting to access the test receive a message indicating that the test is 

not available.  Students scheduled for a test must wait until the instructor changes 

the lesson mode to Take Test at which point the test will start automatically.  

 

• In the Tracker, students who are waiting to take the test show as online 

(highlighted blue) in the Tracker. The wait to start status is shown in the 

Tracker's information field at the bottom of the screen.  

 

 

• As soon as the lesson is placed in Test mode, the Wait to Start message will 

disappear from the students' screens and the test will start.  

 

 

Start Test For All Students 

 

This mode opens the test to all users who enter that lesson, independently of when they 

enter it. The test will remain available until it is placed in the Wait to Start mode again.  

 

If it is important to either start students at the same time, or select which students can 

access the test, please read about the options Start Test For Selected Student and Start 

Test For Online Students Only .  
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When in Test mode, the student will not receive feedback when taking a Multiple Choice 

or Fill-in Item. Answered items titles in the menu are in green to indicate that the item 

has been answered, black when not answered. Wrong MC and fill in the blanks will be 

displayed in green as well, not in red as in practice mode. even if the answer is wrong,  

 

To stop the test mode, or make the test unavailable, select the Wait to Start option again.  

NOTE: While in test mode: Students cannot listen to any message left previously in the 

lesson.  

Start Test for Selected Student  

If testing needs to be done on an individual basis, it is possible to start one student at a 

time, without permitting unauthorized access to the test to the other users.  

 

The procedure is as follows:  

• The lesson must be on Wait to start. When the student logs in and selects the 

lesson, they will see the Waiting... window.  

 
 

• Once the student is in the lesson, the name is highlighted in blue in the Tracker's 

name section.  

• The instructor then selects the name of the user who will take the test by simply 

clicking on it.  

 

In this illustration the instructor selected User 14  
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• To start the test, the instructor selects Test Options from the menu bar, and then 

Start Test For Selected Student. This starts the test for this student and this 

student only.  

 

• Once the instructor started the test for the student, the student's name is 

highlighted in green in the Tracker. 

 

In the example above, there are 2 users started in this test: User 11 and User 14.  

Note:  

 In this mode, there is no way to stop the test once the student has begun. 

  All other students attempting to access that test will receive the message:  

 

Start Test for Online Students Only 

Whereas Start test for all Students makes the test available to all users who access the 

lesson until the test is placed back in Wait to Start mode, Start Test for Online 

Students Only makes the test available to users who are waiting to start (Highlighted 

in blue in the Tracker) at the time the test is started.  

 

Users attempting to access the test once it has been started will receive the Wait to Start 

window and will be denied access to the test until the instructor starts them individually.  



35 

 

For software assistance: support@ can8.com 

 

 

To use the Start Online Students function:  

• simply highlight one of the students whose name is highlighted in blue. 

• select the option Start Test for Online Students Only from the test menu. 

• All users whose names were previously highlighted blue (showing online) will 

now be highlighted in green (taking the test). 

Note:  

  Users entering the lesson after the test is started will be highlighted in blue as they will 

not be able to access the test.  

 Students cannot access oral messages that were left before the test was started.  

Review Results  

At the end of a test the instructor can select Review Results. This mode is indicated in the 

information area at the bottom of the Tracker interface:  

 

 
 

 

This ends the test for students who are not finished.  

 

Students can see the questions, and can see their own answers if they previously took that 

test, but can no longer record or change previous answers, as indicated in the item's 

header bar:  

 

 

 

Any attempt to record or type an answer while the test is in review mode will bring the 

warning message illustrated.  
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Multiple Choice and Fill-in Questions that were correct are show in green; they are 

shown in red if the answer was incorrect. Since the items are corrected by the system, the 

marks for these items are available right away and displayed also.  

 

All other types of items that need to be corrected and marked by instructors are displayed 

in green if they have been answered. If the Instructor has already marked them, the score 

shows beside the item name. If the answer has not been marked yet, only the score the 

answer is out of is displayed.  

 

Items not taken are displayed in black.  

Students now have access to oral messages that were left before the test started.  

 

3. Show Scores  

Selecting this option sorts the students on the Tracker screen by score.  

The highest scoring student is displayed at the top of the screen.  

 

The scores for each student out of the maximum possible (only for the questions taken) 

are shown at the right of the screen. If students continue to work and answer more 

questions, or the instructor assigns more marks, the scores and the maximum for the 

questions are updated. However, the list of students is not sorted again until Show Scores 
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is selected again.  

 

This option has no effect on the students themselves.  

4. Final Mark  

 

Selecting this option when the test is in the Review Results stage will display the final 

marks to the students.  

 

Only the Class Average and Highest (Mark) is common to all students who took that 

test. All other information like Mark and Rank are individual; each student sees his\her 

own mark out of the maximum possible in the test  

The Final Mark is displayed to the student when the Review Results or Practice options 

are selected.  

Note:  

 Although the final mark is displayed when the mode is changed back to practice, it will 

not change if the student answers further questions.  

 The final mark will disappear when the student’s answers are deleted from the tracker.  

Phone 

Calling a Student 

While monitoring a test or a lesson, it might become apparent that one of the students 

needs assistance, either because that student placed a call request (student background 

turns red) or because the instructor notices skipped items or irregularities in the answers.  
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The Net Phone can be used to initiate a real time conversation between an instructor and 

a student. Students cannot initiate that call; only instructors can. However, students can 

send a call request.  

 

A similar phone is displayed on the student's screen asking them to speak to the 

instructor.  

 

To terminate the call to the student, the instructor presses the Exit key.  

 

There are several ways to initiate a call to a student:  

• If the students is in the lesson, the Instructor can initiate the call from the Tracker 

by either  

o  
The instructor first places the cursor on the name of the user to call, and 

then selects Phone > student from the menu Bar. 

 

The Net Phone showing the instructor's voice in the volume display 

appears on the screen.  

o  
Select the student to call then the Phone icon in the Left button bar. The 

Net Phone will start.  

 

• If the student is NOT in the lesson, the instructor can initiate the call by:  
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o  

selecting the Phone icon  

o then the Student List icon  

o and finally, double click on the user name in the list displayed. This list 

only displays users that are online at the time.  

Note:  

 The instructor can talk online to the students who are signed on and using the network. 

Communication is over the network wires directly to the student's computer. As the voice 

is transmitted in real time over the network, the message cannot be saved or edited. 

Students who sign on later will not receive it.  

 

 The SV Net phone can be used to contact a remote student, someone connecting from 

home for example. The user does not have to be on the same network than the instructor, 

as long as they are signed on the same server.  

Interrupting the Class 

The instructor may also speak in real time to the entire class at the same time using the 

Phone Broadcast function.  

 

This function can be accessed:  

•  
By selecting Phone > Broadcast from the menu bar.  

 

•  
Clicking on the phone icon from the left button bar,  

 

 
then the broadcast icon on the SV Phone interface.  
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The SV Net Phone appears on the screen showing the instructor's voice.  

 

Each of the CAN-8 users in an active session will receive an on screen message telling 

them to Listen to the Announcement. 

Note:  

 

All users who are signed in the CAN-8 language lab software which are on the same 

network subnet will see this message and hear the instructor's voice.  

If a CAN-8 user is recording or listening to an item at the time the broadcast is initiated, 

it is paused until the broadcast is terminated.  

Students cannot terminate a broadcast from an instructor  

To terminate this broadcast the instructor must press the Exit button.  

As opposed to the CALL STUDENT phone function, broadcasting cannot be done over 

the Internet.  

Exporting students’ answers 
The Tracker includes the capacity of exporting students' recorded answers into wave 

files, and save them locally, on a network share or a removable disk.  

 
 

 

The instructor may choose to export  

• one specific answer from a student  

• all the answers a student has recorded in a lesson Plan.  

• all the recorded answers from all the students shown in that Tracker.  
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Exporting an answer 

From the Tracker, select the student's answer you wish to export by clicking once on the 

corresponding grey box.  

 

Next select File-->Export-->Single Answer and the Export Item form will open:  

 

• In the Drives section, select the drive you wish to save the answer on, and then 

locate the appropriate folder by scrolling in the Folders section. You may also use 

the Network or browse button if you wish to save this file on a network share. 

• The File Type field shows wave by default.  

• Type a name for the file in the File Name field. This field is mandatory.  

• Finally, Click OK to finalize the process.  

Exporting All of a student's Answers 

From the Tracker 

• Click on the name of the student whose answers you wish to export.  

• Select FILE > EXPORT > Selected Student Answers  

In the Export Item box:  

 

• In the Drives section, select the drive you wish to save the answers on,  
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• then locate the appropriate folder by scrolling in the Folders section. You may 

also use the Network button if you wish to save this file on a network share.  

• The File Type field: By default, this field is pre-set as Wave type. Leave it as is.  

• This export function is automated to export more than one file at a time and each 

answer from the student will be saved as a different wave file. Each file will 

therefore be assigned a different name by the system.  

 

In the File Name field, enter the name of a NEW FOLDER that will be created 

during the export and where these files will be saved.  

 

Since this is a folder, do not add the .wav extension in this field.  

 

Do not type in the name of an existing folder, as this will bring an error box: 

  
 

If the error message appears, select Retry, rename your folder and press OK 

again.  

 

• Finally, Click OK to finalize the process.  

To locate these new files:  

• Navigate to the path you gave in the Drive and Folder section of the export form.  

• Look for the folder that was created during the export.  
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• The 

wave files have automatically been saved in that newly created folder.  

 

The names of these files, assigned by the system is composed of their position in 

the Planner, followed by an under-score and the 4 first letters of this item's name 

in the Planner, as illustrated.  

 

File 006_Exam.wav is the answer to the 6th item in the planner titled Example 

Item.  

Note: 

 If the item's name in the Planner includes an accented character, this character will also 

be replaced by an underscore since accentuation is not permitted in the 8.3 file name 

standard.  

Exporting all students' answers 

 

From the Tracker, select FILE --->EXPORT --> All Answers 

 

the Export Item box will open:  
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• In the Drives section, select the drive you wish to save the answers on.  

• Locate the appropriate folder by scrolling in the Folders section. You may also 

use the Network button if you wish to save this file on a network share.  

• The file type field is pre-set as Wave type.  

• In the File Name field, enter the name of the folder that you wish to create. Since 

this is a folder, do not add the .wav extension in this field. If the folder already 

exists, you will get an error box:  

 
Select Retry, rename your folder and press OK again.  

• Finally, Click OK to finalize the process.  

The system has now created the new folder (in the illustration above, the folder 

2010jan01). 

 

The system will also create a sub-folder for each student and place it inside that new 

folder. The names assigned to the students' folders by the system consists of the number 

that was assigned to the user when they were created on the system. (see User Serial 

Number in the List Display).  
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An index.txt file is also created in the same folder as the student sub-folders containing 

the user number and corresponding user name for each folder.  

 
 

Each sub-folder includes several wave files, one for each answer that this student 

recorded in that lesson. The names of these files are composed of 3 digits, corresponding 

to the item's position in the Planner, followed by an underscore and then the 4 first letters 

of the item's name in the Planner  

Note:  

If the item's name in the Planner includes an accented character, this character will also 

be replaced by an underscore as accentuation is not permitted in the 8.3 file name 

standard.  

Printing the Tracker 

Results can also be printed to either keep as records or hand out to the students.  

 

All information present in the Tracker, including the score per item, subtotals and 

cumulative marks if applicable, is included in the Tracker print out:  
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Note:  

 Where items have been reviewed and marked by the instructor, their score rather than 

their status is shown in the print out. So instead of showing an X for Wrong Answer on a 

wrong Multiple-Choice item, a score of 0 will show.  

 To show the subtotals and/or cumulative marks in the printout, the instructor must first 

display them in the Tracker.  

 

To access the Tracker printer function, select  

 

File > Print Tracker from the menu bar.  

Deleting Student's data 
Once the student's data has been corrected or reviewed, it can be deleted from the 

Tracker. Data deletion is permanent. If it is necessary to keep a copy of their recordings, 

refer to the Exporting Data section of this Chapter.  
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Tracker data can be deleted on a per user basis:  

• Select a student by clicking on the name.  

• Select File > Delete > Selected User from Tracker.  

• Confirmation is required before the data is deleted. Select OK at the prompt.  

To delete all students shown in the Tracker and their data: 

• Access the File > Delete > All Users From Tracker option from the menu bar.  

• Confirmation is required before the data is deleted. Select OK at the prompt.  

All student data will be deleted, and the screen will be cleared.  

Note:  

Deleting users from the Tracker does not delete them from the system.  

Deleting users' data from a Tracker does not affect their Data in other Trackers.  

When a student's data is deleted, all the student's progress and recorded sound files (for 

this lesson only) are deleted.  

When a student's data is deleted, the disk space used to store the recorded files will 

become available for other uses.  

Students who are currently signed on and using the lesson are not affected by either of 

these options. Their data cannot be deleted until they have exited the lesson.  

 

Top  
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